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1 Introduction

1.1 About this document

In many cases problems or errors witnessed with OPUS have been accepted, and it 
has been tried to somehow get on with them. However, this attitude does not help to 
improve the general situation nor solves the specific problem.

Therefore, report any single problem, error or OPUS system crash to the Bruker 
Optik software department. New ideas and suggestions for improvement are also 
welcome.

For important information this document uses the following format:

i The i provides important information given to the user to facilitate troubleshooting in 
specific application issues.

1.2 How to report errors?

• Send an e-mail to: opusbugs@bruker.com

• Use the official OPUS error form available in the intranet (only internal):

file://pia.optik.lan/Home/Groups/QM/Formblaetter/IRENS/FBSOI008.doc

1.3 Mandatory items to be reported in any case

• Exact OPUS version, including date

• Operating system version

• Detailed description of the last steps which have been done or tried to do
5ruker Optik GmbH OPUS Error Reporting
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1.4 Further items to be reported

Depends on the complexity of the problem. Several different types of problems or 
errors are distinguished:

1. Complete operating system crash

2. OPUS crash

3. OPUS disappears

4. Error message in OPUS

5. OPUS interface freezes

The different types of problems or errors which may occur in connection with OPUS 
and their troubleshooting are described in chapter 2.

1.5 How to log errors in Windows 7 or 10

Any type of crash occurred in OPUS is generally logged by the Windows Error 
Reporting (WER) program. So-called dump files, which are more or less reports of 
what happened to the system at the moment before it failed, allow to save program 
information in the dump file, which can be useful for a later debugging. The dump 
file uses the minidump file format with the *.dmp file extension.

If OPUS crashes and prior to its termination, the WER checks the dump file entries 
in the registry1 to determine whether a local dump is to be generated. In the affirma-
tive, OPUS is terminated after the dump file has been generated.

These dumps are configured and controlled independently of the rest of the WER 
infrastructure. You can make use of the local dump collection even if WER is dis-
abled or if the user cancels WER reporting. The local dump can be different to the 
dump sent to Microsoft.

1.  Windows database in which all pieces of information on software and hardware are stored.
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1.5.1 Defining WER as default program

i Defining WER as default program for logging errors requires Administrator user 
rights.

1. Open the Windows Start menu.

2. Select the Run command.

3. On the dialog that opens, enter regedit.

4. Click OK to confirm.

5. Select the following path for the registry parameters:

➣ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\Windows Error 
Reporting\LocalDumps

6. Enter the registry parameters described in chapter 1.5.2.
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1.5.2 Registry parameters for global settings

Value Description Type Default value

DumpFolder

The path where the dump files are to 
be stored. If you do not use the 
default path, the folder must contain 
ACLs that allow the crashing process 
to write data to the folder.
For service crashes, the dump is 
written to service-specific profile fold-
ers depending on the service 
account used.
For example, the profile folder for 
system services is:
%WINDIR%\System32\Con fig\Sys 
temProfile
For network and local services, the 
folder is: %WINDIR%\ServicePro 
files

REG_ 
EXPAN
D_SZ

%LOCALAP 
PDATA%\
Crash-Dumps

DumpCount

The maximum number of dump files 
in the folder. When the maximum 
value is exceeded, the oldest dump 
file in the folder is replaced by the 
new dump file.

REG_D 
WORD

10

Table 1.1:  Registry parameters for global settings
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DumpType

Specify one of the following dump 
types:
• 0: Custom dump
• 1: Mini dump

REG_D 
WORD

1

• 2: Full dump 2

Custom-Dump 
Flags

The custom dump options to be 
used. This value is used only when 
DumpType is set to 0. The options 
are a bitwise combination of the 

MINIDUMP_TYPEa

enumeration values.

REG_D 
WORD

MiniDumpWithData
Segs |
MiniDumpWithUnlo
aded-Modules |
MiniDumpWithProc

essThreadDatab

a. http://msdn.microsoft.com/en-us/library/ms680519(v=VS.85).aspx

b. In hex, this is the value 0x121.

Value Description Type Default value

Table 1.1:  Registry parameters for global settings
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1.5.3 Registry parameters for application-specific settings

i Application-specific registry parameters override the global settings. To create appli-
cation-specific settings, you have to create a new key for your application 
(chapter 1.5.3.1 or 1.5.3.2).

1.5.3.1 Creating key in case of OPUS 8 or >8

1. Open the Windows Start menu.

2. Select the Run command.

3. On the dialog that opens, enter regedit.

4. Click OK to confirm.

5. Select the following path for the registry parameters:

➣ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\Windows Error 
Reporting\LocalDumps\OpusCore.exe

6. Add the dump settings under the OpusCore.exe key.

➣ If OPUS crashes, WER first reads the global settings, and then overrides 
any of the settings by using the application-specific settings.

1.5.3.2 Creating key in case of OPUS 7.8 or <7.8

1. Open the Windows Start menu.

2. Select the Run command.

3. On the dialog that opens, enter regedit.

4. Click OK to confirm.

5. Select the following path for the registry parameters:

➣ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\Windows Error 
Reporting\LocalDumps\opus.exe
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6. Add the dump settings under the opus.exe key.

➣ If OPUS crashes, WER first reads the global settings, and then overrides 
any of the settings by using the application-specific settings.

1.6 How to log errors in Windows XP?

Any type of crash occurred in OPUS is generally logged by Dr Watson. In some 
cases, however, other Windows programs are used to log system crashes. Win-
dows XP, e.g. can be configured such that the Windows Error Reporting (WER) pro-
gram acts instead of Dr Watson.

In this case, a typical Windows error message pops up. It is possible to define Dr 
Watson as standard to trace errors in the form of so-called log files. The steps 
required are described in chapter 1.6.1.

1.6.1 Defining Dr. Watson as log file standard

1. Open the Windows Start menu.

2. Select the Run command.

3. On the dialog that opens, enter drwtsn32 -i.

4. Click OK to confirm.

➣ A message pops up. The message confirms that Dr Watson has been 
installed as standard program to create log files.

5. Click OK to confirm the message.
11ruker Optik GmbH OPUS Error Reporting
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1.6.2 Error messages in Windows

1. As soon as the error message is displayed, open the error report.

➣ The error processing is sent to Dr Watson which generates the correspond-
ing log files.

2. Make a screen shot of the error report contents.

3. Send the screenshot to opusbugs@bruker.com.

➣ Do not send the ’*\accomp.txt’ file to Bruker, as this file does not contain any 
usable data.
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2 Types of errors

The following chapter describes the different types of problems or errors which may 
occur when working with OPUS.

2.1 Complete operating system crash

What happens? Blue screen

Possible cause: • Severe problems with the operating system
• Perhaps a non-conforming driver

What about OPUS? OPUS probably does not cause this problem 
as it is a user-mode program.

Information on the error: • Look at the first two lines on the screen 
(mainly figures).

• Look at the DLL list, written right below 
Name.

• Check drivers recently changed, or new 
hardware components.

• Remove drivers or look for more updated 
ones by contacting the vendor.

Table 2.2:  Complete operating system crash
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2.2 OPUS disappears

What happens? • OPUS completely disappears from the 
screen. 

• Even the OPUS process disappears from 
the Windows Task Manager.

Possible cause: • Any problem with the PC configuration
• So-called Silent Process Exit:

- normal, planned (and silent) exit, due to a 
normally executed (yet possibly unex-
pected) exit request for a component used 
within the OPUS process

- abnormal exit (silent!), due to an unrecov-
erable multi-error problem

• Interaction with other programs

Information on the error: No information available at all, not even a 
message box notification.

What is to be done? • Contact Bruker software department to clar-
ify whether additional debug tools can be 
used.

• Download the debugging tools for Windows 
(e.g. gflags.exe) from the following Microsoft 
Web site: 
http://www.microsoft.com/whdc/dev 
tools/debugging/installx86.mspx

• In case of Windows 7 and higher: activate 
the Silent Process Exit option; or configure 
an interactive debugger, e.g. via windbg -I

Table 2.3:  OPUS disappears
14 OPUS Error Reporting Bruker Optik GmbH
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2.3 Error message in OPUS

 Background information: Very often the hang only occurs when the pro-
cess is under load. The best approach is to 
attach a debugger to the process after it has 
hung (if you can reproduce the problem or 
remote debug), or create a process dump. 

A process dump is almost as good as a live 
debug in these cases, as the state does not 
change much over time; that is as good a defi-
nition of a hang as any other one.

Table 2.3:  OPUS disappears

What happens? OPUS still runs. Error message pops up.

Possible cause: • Any temporary OPUS system error 
• Wrong procedure sequence
• Missing files or methods

Information on the error: Text written in error message

What is to be done? Send a screenshot of the error message to: 
opusbugs@bruker.com

Table 2.4:  Error message in OPUS
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2.3.1 Error message in connection with ADIO/PROCESS

2.4 OPUS interface freezes

What is to be done? Send the ADIO/PROCESS protocol log files 
to opusbugs@bruker.com.

ADIO/PROCESS log file 
path:

• ADIO: <OPUS\ADIO\error.log
• PROCESS: <OPUS\PROCESS\ProcessS 

cenarioSequence.obs\error.log

Table 2.5:  Error message in OPUS

What happens? OPUS does not react to any data input at all.

Possible cause: Several actions running too fast in succes-
sion.

Information on the error: No information available.

What is to be done? • Wait at least 2 minutes to reverse this 
hang-up. Try to minimize the window. Maxi-
mize again to see whether the spectra dis-
play has been refreshed.

• If the hang-up still persists, open the Win-
dows Task Manager to have a look at the 
programme status. End task, if required.

• Send a short description of the situation to 
opusbugs@bruker.com.

Table 2.6:  Error message in OPUS
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2.4.1 Creating dump file for a hanging process

2.4.1.1 In case of Windows 7 or 10 using OPUS 8 or >8

1. Right click the taskbar.

2. From the pop-up menu that opens, select the Start Task Manager (Windows 7) 
or Task Manager (Windows 10) command.

3. Click the Processes (Windows 7) or Details (Windows 10) tab.

4. Right click the OpusCore.exe entry.

5. From the pop-up menu that opens, select the Create Dump File command.

6. Wait until the data are written into the dump file.

7. If the OpusCore.DMP dump file has been created, click OK to confirm the mes-
sage box.

➣ The message box shows the directory which the dump file has been saved 
in. Dump files have the extension ’*.DMP’.

2.4.1.2 In case of Windows 7 or 10 using OPUS 7.8 or <7.8

1. Right click the taskbar.

2. From the pop-up menu that opens, select the Start Task Manager (Windows 7) 
or Task Manager (Windows 10) command.

3. Click the Processes (Windows 7) or Details (Windows 10) tab.

4. Right click the opus.exe entry.

5. From the pop-up menu that opens, select the Create Dump File command.

6. Wait until the data are written into the dump file.

7. If the opus.DMP dump file has been created, click OK to confirm the message 
box.

➣ The message box shows the directory which the dump file has been saved 
in. Dump files have the extension ’*.DMP’.
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2.4.1.3 In case of Windows XP

i The Userdump.exe auxiliary tool is required. Details on the Userdump.exe auxiliary 
tool are described in the Userdocs.doc file. The file is part of the auxiliary tool.

1. Download the Userdump.exe tool, version 8.1 (including the related documen-
tation) from the following Microsoft Web site:

➣ http://www.microsoft.com/download/en/search.aspx?q=Userdump.exe

2. Start the Setup.exe program for the processor.

➣ By default, the ’Setup.exe’ program is part of the ’Userdump.exe’ tool in the 
’C:\kktools\user dump8.1’ folder. The ’Setup.exe’ program installs a ker-
nel-mode driver and the ’Userdump.sys’ file. Additionally, the program gen-
erates the ’Process Dump’ icon in the ’Control Panel’. 

3. If possible, deactivate the Dump on process termination feature when the 
Setup.exe program runs.

4. If the program stops responding, go to the Userdump.exe tool.

5. Select the command line and enter the userdump  <PID> command.

➣ <PID> is a placeholder for the process ID (PID) of the program that has 
stopped responding. To obtain the PID of the program, open the Task Man-
ager, and click the ’Process’ tab.

6. Start the userdump <PID> command.

➣ A file is generated with the ’*.dmp’ extension. 

7. Send the *.dmp file to opusbugs@bruker.com, to perform post-mortem debug-
ging.
18 OPUS Error Reporting Bruker Optik GmbH
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2.5 Windows XP

2.5.1 OPUS crash

2.5.1.1 How to find out the log file protocol path?

1. Open the Windows Start menu.

2. Select the Run command.

3. On the dialog that opens, enter drwtsn32.

4. Click OK to confirm.

➣ A dialog opens showing the log file protocol path. 

What happens? OPUS will be closed automatically.

Possible cause: Any severe OPUS system error, e.g. out of 
memory/resources

Information on the error: Generally, Dr Watson pops up.

Standard log file path: • <\winnt\system32\drwtsn32.log 
• \Documents and Settings\All Users\Applica 

tion Data\Microsoft\Dr Watson (sometimes 
in case of recent systems)

i To find out which log file protocol path 
applies for the OPUS system used (see 
chapter 2.5.1.1), have a look at the Dr Wat-
son for Windows dialog.

Table 2.7:  OPUS crash
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5. Click the Browse button to have the path structure displayed.

6. Click OK to confirm the settings made.

7. Send the log file to opusbugs@bruker.com.

2.5.1.2 Generating a crash dump file

i Usually, it is advisable to create a crash dump file (with user.dmp as file name). This 
type of file is very helpful in case of troubleshooting. The file requires, however, a lot 
of disk space.

1. Open the Windows Start menu.

2. Select the Run command.

3. On the dialog that opens, enter drwtsn32.

4. Click OK to confirm.

5. On the dialog that opens, activate the Full option button to set the file display 
size.

6. Activate the Create Cash Dump File check box.

7. Send the crash dump file to opusbugs@bruker.com.
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3 Error during measurement

If OPUS shuts down, or the interface freezes during measurement, a full report has 
to be generated (chapter 3.1), and the latest, still available measuring results have 
to be saved (chapter 3.2).

3.1 Generating full report

The full report is a useful fault diagnostics tool. This report provides all the neces-
sary information about the instrument configuration and complete spectrometer sta-
tus.

This report also includes error messages, internal and external data transfer as well 
as values of all relevant parameters. The full report is an important and - especially 
if a problem or failure has occurred - indispensable tool for fault diagnostics by ser-
vice engineers.

3.1.1 Via the firmware page of the spectrometer

1 • Open the Web browser.
• Enter the spectrometer IP address 

into the address entry field.
• On the configuration page, click Ser-

vice.

Table 3.8:  Generating full report
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i Save the full report immediately after a problem or failure has occurred. Otherwise, 
important information will be overwritten by newer entries.

3.1.2 Via the OPUS diagnostics page

1. On the Measure menu, select the Optics Diagnostics command.

2. On the dialog that opens, click the Send Report button.

➣ The report is sent to opusreports@bruker.com.

2 • Click the Full Report option.

➣ The current full report is dis-
played.

3 • On the File menu of the Web browser, click the Save as command.
• Use the file extension *.htm.
• Send the original htm file to opusbugs@bruker.com. Do not generate 

any screenshots or text files.

Table 3.8:  Generating full report
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3.2 Saving the latest measuring results

1 • Open the Web browser.
• Enter the spectrometer IP address 

into the address entry field.
• On the configuration page, click Ser-

vice.

2 • Click the List of result data files 
option.

➣ The measuring result list is dis-
played.

3 • On the File menu of the Web browser, click the Save as command.
• Use the file extension *.htm.
• Click the Save button.
• Send the measuring result list to opusbugs@bruker.com.

Table 3.9:  Saving the latest measuring results
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4 Appendix

The appendix contains additional information for systems with the special WinDe-
bug tool installed.

1. Open the WinDebug tool.

2. Enter the following commands into the command line:

• LM (Enter) 

• KV (Enter) 

• R (Enter) 

• U (Enter) 

• DB (Enter) 

3. On the Edit menu, select the Write Window Text to File command.

➣ A log file is created.

4. Send the log file to opusbugs@bruker.com.

For further information refer to: http://support.microsoft.com/kb/892277
25ruker Optik GmbH OPUS Error Reporting

http://support.microsoft.com/kb/892277


Appendix 4
26 OPUS Error Reporting Bruker Optik GmbH



B

Index

D
Dump file ......................................................6, 17, 20

F
Firmware page.......................................................21
Full report ...............................................................21

Generating .....................................................21, 23

M
Measuring result list .............................................23

R
Registry.....................................................................6
Registry parameters .........................................8, 10

S
System crash.........................................................13

U
User interface ........................................................16
Userdump...............................................................18

W
WER......................................................................6, 7
WinDebug...............................................................25
27ruker Optik GmbH OPUS Error Reporting



Index
28 OPUS Error Reporting Bruker Optik GmbH


	Table of Contents
	1 Introduction
	1.1 About this document
	1.2 How to report errors?
	1.3 Mandatory items to be reported in any case
	1.4 Further items to be reported
	1.5 How to log errors in Windows 7 or 10
	1.5.1 Defining WER as default program
	1.5.2 Registry parameters for global settings
	1.5.3 Registry parameters for application-specific settings

	1.6 How to log errors in Windows XP?
	1.6.1 Defining Dr. Watson as log file standard
	1.6.2 Error messages in Windows


	2 Types of errors
	2.1 Complete operating system crash
	2.2 OPUS disappears
	2.3 Error message in OPUS
	2.3.1 Error message in connection with ADIO/PROCESS

	2.4 OPUS interface freezes
	2.4.1 Creating dump file for a hanging process

	2.5 Windows XP
	2.5.1 OPUS crash


	3 Error during measurement
	3.1 Generating full report
	3.1.1 Via the firmware page of the spectrometer
	3.1.2 Via the OPUS diagnostics page

	3.2 Saving the latest measuring results

	4 Appendix
	Index


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /CMYK
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments true
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /CreateJDFFile false
  /Description <<

    /BGR <>
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000410064006f006200650020005000440046002065876863900275284e8e9ad88d2891cf76845370524d53705237300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef69069752865bc9ad854c18cea76845370524d5370523786557406300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /CZE <>
    /DAN <>
    /DEU <>
    /ESP <>
    /ETI <>
    /FRA <>
    /GRE <>

    /HRV (Za stvaranje Adobe PDF dokumenata najpogodnijih za visokokvalitetni ispis prije tiskanja koristite ove postavke.  Stvoreni PDF dokumenti mogu se otvoriti Acrobat i Adobe Reader 5.0 i kasnijim verzijama.)
    /HUN <>
    /ITA <>
    /JPN <FEFF9ad854c18cea306a30d730ea30d730ec30b951fa529b7528002000410064006f0062006500200050004400460020658766f8306e4f5c6210306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103055308c305f0020005000440046002030d530a130a430eb306f3001004100630072006f0062006100740020304a30883073002000410064006f00620065002000520065006100640065007200200035002e003000204ee5964d3067958b304f30533068304c3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020ace0d488c9c80020c2dcd5d80020c778c1c4c5d00020ac00c7a50020c801d569d55c002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /LTH <>
    /LVI <>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken die zijn geoptimaliseerd voor prepress-afdrukken van hoge kwaliteit. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /POL <>
    /PTB <>
    /RUM <>
    /RUS <>
    /SKY <>
    /SLV <>
    /SUO <>
    /SVE <>
    /TUR <>
    /UKR <>
    /ENU (Use these settings to create Adobe PDF documents best suited for high-quality prepress printing.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /ConvertToCMYK
      /DestinationProfileName ()
      /DestinationProfileSelector /DocumentCMYK
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure false
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles false
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /DocumentCMYK
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /UseDocumentProfile
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


